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Contact Us!

Oracle Web Publishing Assistant Getting Started, Release 8.1.6 for Windows NT

Part No.  A73026-01

This document describes how to contact Oracle Corporation if you have issues with the 
documentation or software. It also provides a list of useful resources for Oracle partners and 
developers.

 

Read the section... If you...

How to Contact Oracle Technical Publications on page vi Have issues with Documentation

How to Contact Oracle Support Services on page vii Have issues with Software

Resources for Oracle Partners and Developers on page xi Want to join an Oracle partner or application 
developer program
v



How to Contact Oracle Technical Publications
Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this 
publication. Your input is an important part of the information used for revision.

■ Did you find any errors?
■ Is the information clearly presented?
■ Do you need more information? If so, where?
■ Are the examples correct? Do you need more examples?
■ What features did you like most about this guide?
■ Do you have suggestions for improvement? Please indicate the chapter, section, and page 

number (if available). 

You can send comments regarding documentation in the following ways:

■ Electronic mail - ntdoc@us.oracle.com
■ FAX - (650) 506-7370   Attn:  Oracle Windows Platforms Server Documentation
■ Postal service:

Oracle Corporation 
Windows Platforms Server Documentation Manager
500 Oracle Parkway, MS 1OP8,
Redwood Shores, CA  94065
USA

If you would like a reply, please provide your name, address, and telephone number.
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How to Contact Oracle Support Services
Please copy this form and distribute within your organization as necessary.

Oracle Support Services can be reached at the following telephone numbers and Web sites. The hours 
of business are detailed in your support contract and the Oracle Customer Support Guide in your kit.

Please complete the following checklist before you call. If you have this information ready, your call 
can be processed much quicker.

❏ Your CPU Support Identification Number (CSI Number) if applicable.

❏ The hardware name on which your application is running. 

Oracle Support 
Services In... Call...

United States of 
America

+ (650) 506-1500 for customers with support contracts.

+ (650) 506-5577 to obtain a support contract.

Europe +44 1344 860 160 or the local support center in your country.

All other 
locations

The telephone number for your country listed at the following Web site:

http://www.oracle.com/support/contact_us/sup_hot_
phone.html

Oracle Support Services telephone numbers are also listed in the Oracle 
Customer Support Guide in your kit.
vii



❏ The operating system name and release number on which your application is 
running.

■ To verify the operating system version on Windows NT, enter the following 
at the MS-DOS command prompt:

C:\> WINMSD

The Windows NT Diagnostics dialog box displays the operating system and 
Service Pack version.

❏ The release numbers of the Oracle Server and associated products involved in 
the current problem. For example, Oracle8i Enterprise Edition release 8.1.6.0.0 
and Oracle Enterprise Manager release 2.1.0.0.0.

■ To verify the release number of the Oracle Server, connect to the database 
using a tool such as SQL*Plus. The release number is displayed. For 
example:

Connected to: 
Oracle8i Enterprise Edition Release 8.1.6.0.0 - Production 
With the Partitioning and Java options 
PL/SQL Release 8.1.6.0.0 - Production 

❏ The third-party software version you are using.

■ To verify an application version, from the application’s Help menu, select 
About... 
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❏ The exact error codes and messages. Please write these down as they occur. 
They are critical in helping Oracle Support Services to quickly resolve your 
problem. Note whether there were no errors reported.

❏ A description of the issue, including:

■ What happened? For example, the command used and its result. 
 

■ When did it happen? For example, during peak system load, or after a 
certain command, or after an operating system upgrade. In addition, what 
was happening when the problem occurred? 

■ Where did it happen? For example, on a particular system, or within a 
certain procedure or table.
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■ What is the extent of the problem? For example, production system 
unavailable, or moderate impact but increasing with time, or minimal 
impact and stable. 

■ Did the problem affect one user, several users, or all users? 

■ Has anything changed? For example, if this is an operation that used to 
work and now fails, what is different? Can you undo any recent changes, to 
verify whether they are relevant to the issue? 

■ Can the problem be reproduced? This is a critical question for support 
analysts. For example, did the problem recur on the same system, under the 
same circumstances? Can the problem be reproduced on another system? 
Additionally:

■ Does installing a software component fail on all client machines, or just 
one? 

■ Do all clients fail to connect to the server, or just one?

■ If you are able to restart the server or database, does restarting the database 
or rebooting the server or client machine (if applicable) make a difference?

❏ Keep copies of the Oracle alert log, any trace files, core dumps, and redo log 
files recorded at or near the time of the incident. Oracle Support Services may 
need these to further investigate your problem. 

To help analyze problems: 

■ Archive or delete old alert logs. When the database is started without an 
alert log, a new one is created. In some cases, if you force the problem to 
recur with a new alert log, the timestamps for the recorded events may 
indicate which events are relevant. 
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■ Archive or delete old trace files. To check whether the file was modified, 
right-click and select Properties. The Properties dialog box displays the 
modification date.

■ Check the operating system error logs, especially the System log and 
Application log. These files are relevant to the Oracle Server. To view these 
files, from the Start menu, choose Programs > Administrative Tools > Event 
Viewer, and choose System or Application from the Log main menu. 

Resources for Oracle Partners and Developers
This section provides information on partner programs and resources for Oracle database 
administrators and application developers.

Information Source Description

Oracle Corporation Home Page

http://www.oracle.com

This Web site is the starting point for general information on 
Oracle Corporation.

Alliance Online

http://alliance.oracle.com

Oracle provides leading-edge technology, education, and 
technical support that enables you to effectively integrate 
Oracle into your business. By joining the Oracle Partner 
Program, you demonstrate to customers that you are 
committed to delivering innovative Oracle-based solutions 
and services.

The greater your commitment to Oracle, the more we can 
help you grow your business. It’s that simple. The value you 
derive is associated directly with your level of commitment.

Oracle Education

http://education.oracle.com/

Customers come to Oracle Education with a variety of 
needs. You may require a complete curriculum based on 
your job role to enable you to implement new technology. Or 
you may seek an understanding of technology related to 
your key area of responsibility to help you meet technical 
challenges. You may be looking for self-paced training that 
can be used as an ongoing resource for reference and 
hands-on practice. Or, you may be interested in an overview 
of a new product upgrade. Whatever your training need, 
Oracle Education has the solution. 
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Oracle Technology Network

http://technet.oracle.com/

The Oracle Technology Network is your definitive source for 
Oracle technical information for developing for the Internet 
platform. You will be part of an online community with 
access to free software, Oracle Technology 
Network-sponsored Internet developer conferences, and 
discussion groups on up-to-date Oracle technology. 
Membership is free.

Oracle Store

http://oraclestore.oracle.com/

This is Oracle’s online shopping center. Come to this site to 
find special deals on Oracle software, documentation, 
publications, computer-based training products, and much 
more.

Oracle Support Services’ Support Web Center

http://www.oracle.com/support/

Oracle Support Services offers a range of programs so you 
can select the support services you need and access them in 
the way you prefer: by telephone, electronically, or face to 
face. These award-winning programs help you maintain 
your investment in Oracle technology and expertise.

Here are some of the resources available in the Support Web 
Center:

OracleMetaLink

http://www.oracle.com/support/
elec_sup/index.html

OracleMetaLink is Oracle Support Services' premier Web 
support service. It is available to Oraclemetals customers 
(Gold, Silver, Bronze), 24 hours a day, seven days a 
week.

OracleLifecycle

http://www.oracle.com/support/
sup_serv/lifecycle/index.html

OracleLifecycle is designed to deliver customized, 
industry-focused, full life-cycle support solutions that 
enable industry leaders to use Oracle technology to 
make smart business decisions, achieve operational 
excellence, and succeed in their markets.

ExpertONLINE

http://www.oracle.com/support/
sup_serv/online/index.html

Oracle Support Services has launched a new line of 
services called ExpertONLINE. These services provide 
online database administration for companies looking 
to supplement their existing DBA staff or fill a DBA 
role. Services range from ExpertDETECT, a monitoring, 
diagnostic, and recommendation service, to ExpertDBA, 
a full online database administration service.

Virtual Support Analyst (VSA)

http://www.oracle.com/support/
sup_serv/vsa_start.html

VSA is Oracle's Internet e-mail service; it is available to 
U.S. customers with an Oraclemetals support agreement. 
With VSA, you can initiate a request for assistance 
through e-mail, bypassing the queues you may 
encounter when using telephone support. VSA also 
enables you to access Oracle's bug database.

Information Source Description
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Customer Service

http://www.oracle.com/support/
cus_serv/index.html

This site provides resources to make your interactions 
with Oracle as easy as possible. Among the things you 
can do are:

■ Learn what is a CPU Support Identification (CSI) 
number

■ Update your technical contact information

■ Find out whom to contact for invoice and collection 
issues

■ Request product update shipments

■ Access a glossary of Oracle Support Services terms

U.S. Customer Visit Program

http://www.oracle.com/support/
cus_serv/cus_visit.html

This U.S.-based program has been established to help 
our customers understand and obtain maximum benefit 
from the support services they have purchased.

The visit typically offers a customized orientation 
presentation, a comprehensive overview and 
demonstration of Oracle’s electronic services, and 
helpful tips on working more effectively with Oracle 
Support Services.

Support Web Center Library

http://www.oracle.com/support/
library/index.html

This site contains articles, guides, and other 
documentation to help you leverage the wealth of 
knowledge and reference material that Oracle Support 
Services produces.

Information Source Description
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Before You Begin

This guide is your primary source of information for using Oracle Web Publishing 
Assistant for Windows NT.

Specific topics discussed are:

■ Prerequisites

■ Intended Audience

■ How this Guide Is Organized

■ Documentation and Code Conventions

■ Related Documents
xv



Prerequisites
This guide assumes that you are familiar with the following:

■ Windows NT, and have installed and tested it on your computer system

■ Object-relational database management concepts

Intended Audience
This manual is intended for anyone who wants to display database query results in 
HTML format. You must have Windows NT User Login privileges on the machine 
you query from to use Oracle Web Publishing Assistant. You need a Windows NT 
Administrator account to install and maintain Oracle Web Publishing Assistant.

How this Guide Is Organized
This guide contains the following chapters and appendices:

Chapter 1, "Introducing Oracle Web Publishing Assistant" Introduces Oracle Web 
Publishing Assistant. Discusses system requirements and installation

Chapter 2, "Understanding Oracle Web Publishing Assistant" Explains basic 
product architecture and use. 

Chapter 3, "Working with Oracle Web Publishing Assistant" Describes how to use 
Oracle Web Publishing Assistant. Describes the interface, how to perform tasks, and how to 
administer queries.

Chapter 4, "Using the Tutorials" Provides instructions on how to use included tutorials.

Appendix A, "Oracle Web Publishing Assistant Repository" Explains the repository 
entries.

Appendix B, "Troubleshooting" Describes common questions and solutions to common 
problems.

Additional Information: If you are not familiar with 
object-relational database management concepts, see Oracle8i 
Concepts.
xvi



Documentation and Code Conventions
The following conventions are used in this guide: 

Convention Example Meaning

All uppercase plain C:\ORACLE\ORA81 Indicates command names, SQL reserved 
words, and keywords, as in ALTER 
DATABASE. All uppercase plain is also 
used for directory names and file names.

Italic ■ Used to indicate a variable:

file name

■ Used to indicate the title of a guide.

Indicates a value that you must provide. 
For example, if a command asks you to 
type file name, you must type the actual 
name of the file.

Square brackets [ ] X:\[PATHNAME]\ORACLE\
HOME_NAME

Encloses optional items. For example, 
when you create an OFA-compliant 
Oracle home directory, you can place an 
optional pathname before the \ORACLE 
pathname.

Square brackets also indicate a function 
key, for example [Enter].

Choose Start > Choose Start > Programs > Oracle - 
HOME_NAME > Network Administration 
> Net8 Easy Config

How to start a program. For example, to 
start Net8 Easy Config, you must click the 
Start button on the taskbar and then 
choose Programs, Oracle - HOME_NAME > 
Network Administration > Net8 
Easy Config. 

C:\> C:\ORACLE\ORADATA> Represents the Windows NT command 
prompt of the current hard disk drive. 
Your prompt reflects the subdirectory in 
which you are working. Referred to as the 
MS-DOS command prompt in this guide.

Backslash (\) before a 
directory name

\ORADATA Indicates that the directory is a 
subdirectory of the root directory.
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ORACLE_HOME and 
ORACLE_BASE

Go to the ORACLE_BASE\ORACLE_
HOME\RDBMS\ADMIN directory

In releases prior to 8.1, when you 
installed Oracle8i Enterprise Edition or 
Oracle8i for Windows NT, all 
subdirectories were located under a top 
level Oracle home directory, that by 
default was: 

C:\ORANT for Windows NT 

C:\ORAWIN95 for Windows 95/98 

or whatever you may have called your 
Oracle home. 

In this Optimal Flexible Architecture 
(OFA)-compliant release, all 
subdirectories are no longer under a top 
level ORACLE_HOME directory. There is 
now a new top-level directory called 
ORACLE_BASE that by default is 
C:\ORACLE. If you install Oracle8i 
Enterprise Edition or Oracle8i for 
Windows NT release 8.1.6 on a clean 
computer (that is, there is no other Oracle 
software on the computer), the default 
settings for the first Oracle home 
directory is C:\ORACLE\ORA81. If you 
run Oracle Universal Installer again and 
install release 8.2.x, the second Oracle 
home directory is called \ORA82. These 
Oracle home directories are located 
directly under ORACLE_BASE. All 
directory path examples in this guide 
follow OFA conventions.

%ORACLE_HOME% SQL> @%ORACLE_
HOME%\ADMIN\DB_
NAME\ADHOC\CATALOG.SQL

In SQL*Plus commands, you may see 
%ORACLE_HOME%. SQL*Plus is able to 
locate your Oracle Home directory using 
the %ORACLE_HOME% variable. This 
convention can be used in Server 
Manager, SQL*Plus, Export Utility, and 
Import Utility.

Convention Example Meaning
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HOME_NAME OracleHOME_NAMETNSListener Represents the Oracle home name.

The home name can be up to sixteen 
alphanumeric characters. The only special 
character allowed in the home name is the 
underscore. 

HOMEID HOME0, HOME1, HOME2 Represents a unique registry subkey for 
each Oracle home directory in which you 
install products. A new HOMEID is 
created and incremented each time you 
install products to a different Oracle home 
directory on one computer. Each 
HOMEID contains its own configuration 
parameter settings for installed Oracle 
products.

Symbols period  .

comma  ,

hyphen  -

semicolon  ;

colon  :

equal sign  =

backslash  \

single quote  ’

double quote  "

parentheses ()

Symbols other than brackets and vertical 
bars must be entered in commands 
exactly as shown.

Convention Example Meaning
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Related Documents
For more information, see the following guides.

■ Oracle8i Enterprise Edition Installation Guide

■ Oracle8i Enterprise Edition Release Notes

■ Oracle8i Enterprise Edition Getting Started 

■ Using Microsoft Transaction Server With Oracle8

■ Oracle Enterprise Manager Administrator’s Guide

■ Oracle Parallel Server Administrator’s Guide for Windows NT

■ Net8 Administrator’s Guide

■ Getting to Know Oracle8i

■ Oracle8i Concepts

■ Oracle8i Reference
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Introducing Oracle Web Publishing Ass
1

Introducing Oracle Web Publishing

Assistant

This chapter provides an overview of the Oracle Web Publishing Assistant. It also 
lists the system requirements and describes how to get started using the product. 

Specific topics discussed are:

■ Introducing Oracle Web Publishing Assistant

■ Recent Feature Updates

■ About the Interface

■ Hardware Requirements

■ Software Requirements

■ Installing Oracle Web Publishing Assistant

■ De-installing Oracle Web Publishing Assistant
istant 1-1



Introducing Oracle Web Publishing Assistant
Introducing Oracle Web Publishing Assistant
You have an Oracle database and tablespaces filled with useful information. You 
want to share this information with your co-workers, customers, and the rest of the 
world. How can you get this information, and present it in an easy-to-read format?

Oracle Web Publishing Assistant Web-enables an Oracle database, offering high 
performance and scalability with a user-friendly interface. Use the Oracle Web 
Publishing Assistant Create Web Page Wizard to create Web page queries which are 
displays of data retrieved from an Oracle database merged with HTML Web pages. 
The default HTML template provided with Oracle Web Publishing Assistant is 
Java-enabled, providing scalability to accommodate your query results. Oracle Web 
Publishing Assistant uses database connection sharing and the Oracle Call Interface 
(OCI8) to improve performance and maximize server resources.

To make the Web page available on an intranet or the World Wide Web, you must 
configure a Web server. A Web server is not necessary if you only want to view the 
page locally. To view the page locally, use your Web browser to open the file. See 
"Software Requirements" on page 1-6.

Note: To use Oracle Web Publishing Assistant, you need Windows 
NT User Login privileges on the computer from which you query.

You can download trial versions of Oracle Web Server or Oracle 
Web Application Server from the Oracle Corporation Web site at 
http://www.oracle.com.
1-2 Oracle8i Installation Guide for Windows NT



Recent Feature Updates
Recent Feature Updates
This release of Oracle Web Publishing Assistant offers updated features:

■ The Preview function replaces the Open function. To preview a Web page, click 
Preview on the toolbar. The Web page is opened with your Web browser. See 
"Administering Web Page Queries" on page 3-11 for more information.

■ The “When Data Changes” scheduling option has been added to the scheduling 
options. This scheduling option when selected allows Oracle Web Publishing 
Assistant to automatically update your Web page query whenever the database 
is modified. See "Creating New Web Page Queries" on page 3-3 for more 
information.

■ The “Manually” scheduling option has been added to the scheduling options. 
This scheduling option requires you to manually generate your Web page by 
clicking Generate. See "Creating New Web Page Queries" on page 3-3 for more 
information.

■ Modification of file properties is now possible when you open the properties of 
an existing Web page query. You can change any aspect of the Web page query, 
including the template, scheduling option, and the query. See "Administering 
Web Page Queries" on page 3-11 for more information.

■ The default template .HTX uses a Java applet, which provides high scalability 
and reliable formatting across different platforms and browsers. See "Tutorial 1: 
Using the Generated Default Template" on page 4-2 for more information.

■ The template syntax now includes more keywords to enable greater control in 
displaying query results. See "Designing Templates" on page 2-2 for more 
information.

■ Oracle Web Publishing Assistant now uses database connection sharing and the 
Oracle Call Interface version 8 (OCI8) to improve performance.

■ Synonyms of tables or views can be selected from the database hierarchy to 
build queries. See "Creating New Web Page Queries" on page 3-3.

■ The file listing is automatically refreshed every minute.

■ The scheduling option uses buttons instead of drop-down lists, improving the 
interface. See "Creating New Web Page Queries" on page 3-3.

■ The maximum characters per column returned from the database has been 
increased from 2000 to 4000.
Introducing Oracle Web Publishing Assistant 1-3



About the Interface
About the Interface
Oracle Web Publishing Assistant features an easy-to-use toolbar interface that 
enables you to create new and administer existing Web page queries:

Menu and Toolbar
Perform administrative tasks using either the menu or the toolbar. The menu 
provides the same functionality as the toolbar, but the menu also includes 
commands that enable you to modify the look of Oracle Web Publishing Assistant. 
For example, you can change the listing to icons, and display or hide the status bar 
and toolbar.

The toolbar provides easy access to Oracle Web Publishing Assistant functionality:
 

Toolbar Button Task Performed

New Creates a new Web page query.

Preview Opens the Web page query in your Web browser.

Generate Generates a Web page immediately.

Delete Deletes a Web page query.

menu

toolbar
file listing of Web 
page queries
1-4 Oracle8i Installation Guide for Windows NT



Hardware Requirements
File Listing
The file listing shows you the:

■ Web page query files that you have scheduled

■ location of the files in your system

■ scheduling option you have specified for that Web page query

■ last date and time the Web page query was modified

Double-click a Web page query file name in the listing to preview the Web page in 
your Web browser. Because Oracle Web Publishing Assistant uses an asynchronous 
processing model, the actual Web page may not have been generated immediately. 
If the page does not yet exist when you double-click the file in the listing or click 
Preview, Oracle Web Publishing Assistant prompts you to create the page 
immediately.

Hardware Requirements
Oracle Web Publishing Assistant requires these hardware components:

■ Compaq, Hewlett-Packard, or 100% compatible PC with 80486 processor or 
faster

■ 32 MB RAM

■ 10 MB hard disk space

■ CD-ROM drive

Properties Allows you to view and modify the properties of the Web page 
query: 

■ login information

■ query syntax

■ scheduling

■ file options and template file

Help Displays online help topics.

Toolbar Button Task Performed
Introducing Oracle Web Publishing Assistant 1-5



Software Requirements
Software Requirements
Oracle Web Publishing Assistant requires these software components:

Installing Oracle Web Publishing Assistant
Before installing this product, review Oracle8i Enterprise Edition Release Notes 
included in this package for the most recent information about this product.

Oracle Web Publishing Assistant is automatically installed with Oracle8i for 
Windows NT, if you choose a Typical installation.

Software Component Release

Microsoft Windows NT Workstation or Server operating system 4.0.x

Oracle8i Required Support Files (or RSF) 8.1.6

Net8 for accessing a remote Oracle8i or Oracle7 Server 8.1.6

Web browser

■ Netscape Navigator. Visit: 

http://www.netscape.com

or

■ Microsoft Internet Explorer. Visit:

http://www.microsoft.com

4.0.x

Note: You must have a Windows NT Administrator account to 
install and maintain Oracle Web Publishing Assistant.

See Oracle8i Installation Guide for Windows NT for instructions.
1-6 Oracle8i Installation Guide for Windows NT



De-installing Oracle Web Publishing Assistant
De-installing Oracle Web Publishing Assistant
To de-install Oracle Web Publishing Assistant:

1. Stop Oracle Web Publishing Assistant services. 

a. Choose Start > Settings > Control Panel.

b. Double-click Services.

c. Select OracleWebAssistant, and click Stop.

d. Click Close to close the control panel.

2. Choose Start > Programs > Oracle Installation Products > Oracle Universal 
Installer.

The Welcome window for Oracle Universal Installer appears.

3. Click Installed Products.

The Inventory dialog box appears.

4. Select Oracle Web Publishing Assistant and click Remove. 

The Inventory confirmation dialog appears. 

5. Click Yes to remove the selected components. 

6. Click Close to close the Inventory dialog box.

7. Click Exit to exit Oracle Universal Installer.
Introducing Oracle Web Publishing Assistant 1-7



De-installing Oracle Web Publishing Assistant
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Understanding Oracle Web Publishing Ass
2

Understanding Oracle Web Publishing

Assistant

This chapter discusses how the different components of Oracle Web Publishing 
Assistant work together to deliver Web-enabled Oracle database information. 

Specific topics discussed are:

■ Using Sample Templates

■ Designing Templates

■ Generated Web Page Queries

■ Settings in the Windows NT Registry
istant 2-1



Using Sample Templates
Using Sample Templates
Oracle Web Publishing Assistant provides you with sample templates (located in 
ORACLE_BASE\ORACLE_HOME\ASSISTANTS\OWAST\SAMPLES). Use these 
templates to become familiar with creating Web page queries. 

The default template (.HTX) uses a Java applet to format the database query 
information into a spreadsheet-like Web page. The new Java-enabled Web page 
template:

■ expands to accommodate query results

■ provides reliable formatting

■ allows browser independence

See Chapter 4, "Using the Tutorials" for more information on the available 
templates.

Designing Templates
If you want to design your own templates, use the Oracle Web Publishing Assistant 
keywords in the HTML extension files (.HTX) to control how the Web page is 
constructed. The Oracle Web Publishing Assistant keywords used in .HTX files are:

■ Keyword <%begindetail%>, <%enddetail%>

■ Conditional Logic Keyword <%if%>, <%else%>, <%endif%>

■ Variable CurrentRecord

■ Variable CurrentDate

■ Variable MaxColumn

■ Variable QueryId

The template syntax is supported by HTML editors like Microsoft Frontpage. 
Templates can be modified at any time. Oracle Web Publishing Assistant uses the 
modified template when generating your Web page at the next scheduled 
generation time.

If you modify your original query after generating a Web page, then Oracle Web 
Publishing Assistant prompts you to modify your template. Oracle Web Publishing 
Assistant launches your default template editor. You can then choose to use the 
original template, modify your existing template, or use a new template. See 
"Administering Web Page Queries" on page 3-11 and Oracle Web Publishing 
Assistant Online Help for more information.
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Keyword <%begindetail%>, <%enddetail%>
This keyword surrounds a section of the HTML extension file in which the data 
output from the Oracle database will be merged. Within the section, the column 
names are delimited with <% and %> which are used to mark the position of the 
data returned from the query.

For example:

<%begindetail%>
<%ename%>: <%sal%>
<%enddetail%>

lists the columns ENAME (employee name) and SAL (salary). You can refer to any 
column in this manner. You can refer to column names in other sections of the 
extension file. If no records are returned from the query, the <%begindetail%> 
section will be omitted.

Conditional Logic Keyword <%if%>, <%else%>, <%endif%>
Your template can contain conditional logic with an if-then-else statement to control 
how the Web page is constructed. One common usage of an if-then-else statement is 
to insert a condition to display the results from the query on the first row with a 
<%begindetail%> section. If no records are returned by the query, the following 
message appears in the resulting HTML file:

Sorry, no employees had salaries greater than 5000.
By using the <%if%> statement and a built-in variable CurrentRecord, you can 
tailor the output so that the error message is displayed when no records are 
returned by the query.

The syntax is structured as:

<%if condition%>
HTML text
[<%else%>
HTML text]
<%endif%>

Note: Conditional logic statements must exist entirely before, 
inside, or after the <%begindetail%> and <%enddetail%> block.

Nested <%if%> statements are not allowed (you cannot nest an 
<%if%> statement within a <%if%> statement.
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where condition is of the form:

value1 operator value2
and operator can be one of the following:

The operands value1 and value2 can be column names, a built-in variable, or a 
constant. See the section "Variable CurrentRecord" on page 2-5 for more 
information.

Here is an example:

<HTML>
<BODY>
<%begindetail%>
<%if CurrentRecord EQ 0 %>
<B>Employee Name Salary<BR></B>
<%endif%>
<%ename%>:<%sal%>
<%enddetail%>
<P>
<I>
This web page was created by merging the results of the SQL query with the 
template file EXAMPLE2.HTX.
<P>
The merge was performed by Oracle Web Publishing Assistant and the results were 
stored in a web page.
</I>
</BODY>
</HTML>
When used in an <%if%> statement, values are not delimited with <% and %>. For 
example, to process employee name Scott, use the condition:

<%begindetail%>
<%if ename EQ “Scott”%>
The employee is Scott.
<%endif%>
<%enddetail%>

Operator If...

EQ value1 equals value2

LT value1 is less than value2

GT value1 is greater than value2

CONTAINS any part of value1 contains the string value2
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Variable CurrentRecord
The CurrentRecord variable contains the number of times the <%begindetail%> 
section has been processed. The first time through the <%begindetail%> section, the 
value is zero (0). The value of CurrentRecord changes every time another record is 
retrieved from the database.

Variable CurrentDate
The CurrentDate variable shows the date and time of the Web page generation. This 
variable cannot be used inside <%if%> statements. If you do not specify a date 
format, the default format used is DD/MMM/YYYY (for example, 05/MAY/1999). 
The default time format is HH:MM:SS A.M./P.M. (for example, 10:01:15 A.M.). You 
can change the date and time format using these codes:

Format Code Description

%a Abbreviated weekday name

%A Full weekday name

%b Abbreviated month name

%B Full month name

%c Date and time representation appropriate for locale

%d Day of month as decimal number (01 ? 31)

%H Hour in 24-hour format (00 - 23)

%I Hour in 12-hour format (01 - 12)

%j Day of year as decimal number (001 - 366)

%m Month as decimal number (01 - 12)

%M Minute as decimal number (00 - 59)

%p A.M./P.M. indicator for 12-hour clock in current locale

%S Second as decimal number (00 - 59)

%U Week of year as decimal number, with Sunday as first day of week 
(00 - 51)

%w Weekday as decimal number (0 - 6; Sunday is 0)

%W Week of year as decimal number, with Monday as first day of week 
(00 - 51) 
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The # flag may prefix any formatting code, and the meaning of the format code is 
changed as follows:

Here is an example using the CurrentDate variable:

<%CurrentDate:Today is %A, day %d of %B in the year %Y %>
which translates into the actual date when the Web page is generated:

Today is Tuesday, day 8 of June in the year 1999

Variable MaxColumn
The MaxColumn variable <%MaxColumn%> specifies the number of columns 
returned by the query.

%x Date representation for current locale

%X Time representation for current locale 

%y Year without century, as decimal number (00 - 99)

%Y Year with century, as decimal number (for example, 1998)

%z Time zone abbreviation; no characters if time zone is unknown

%Z Time zone name; no characters if time zone is unknown

Format Code Description

%#c Long date and time representation, appropriate for current locale; 
for example: Tuesday, June 8, 1999, 12:41:29

%#x Long date representation, appropriate to current locale; for 
example: Tuesday, June 8, 1999

%#a, %#A, %#b, %#B, 
%#p, %#X, %#z, %#Z, 
%#%

# flag is ignored

%#d, %#H, %#I, %#j, 
%#m, %#M, %#S, %#U, 
%#w, %#W, %#y, %#Y

Removes leading zeros (if any)

Format Code Description
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Variable QueryId
The QueryId variable <%QueryId%> provides a unique identifying number for the 
generated Web page. You can use this number when troubleshooting Oracle Web 
Publishing Assistant. See Appendix B, "Troubleshooting" for more information.

Generated Web Page Queries
Web page queries generated by Oracle Web Publishing Assistant consist of two 
types of information:

This model of page generation has two benefits:

■ Flexibility

The template layout is compatible with popular HTML editors such as 
Microsoft Frontpage. You can modify the templates in any way you want, 
whenever you want.

■ Performance

The database does not need to be accessed every time a Web page is viewed. 
The database only needs to return results from the query, therefore performance 
is not negatively impacted.

Information Type Description

Static Information Stored in a template.

Dynamic Information Retrieved from the database and merged with the 
static information from the template.
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Settings in the Windows NT Registry
Oracle Web Publishing Assistant registry values are located under the key HKEY_
LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID.
.

To modify the settings of the repository values OWASTDBS and OWASTDBC:

1. From the MS-DOS command prompt, enter:

C:\> REGEDT32

The Registry Editor window appears.

Value Description

OWASTDBS The default value is OFF. The possible values are ON or OFF.

The OFF setting disables database connection sharing.

OWASTDBC The default value is 1000. The available range is 
1...INFINITY.

The number of seconds between database polls, to discover if 
database information has changed since last poll. A lower 
number means a shorter amount of time between database 
data change and Web page generation, but a lower number 
also increases CPU usage.

If this value is not present in the registry, then Oracle Web 
Publishing Assistant is using the default value of 1000.

OWASTHOME The default value is OracleWebAssistant.

The name of the Oracle Web Publishing Assistant Windows 
NT service used in conjunction with multiple Oracle homes.

This value is not displayed in the registry. Do not change this 
value.

OWAST The default value is ORACLE_BASE\ORACLE_
HOME\ASSISTANTS\OWAST.

The Oracle home directory where Oracle Web Publishing 
Assistant is installed. Do not change this value.
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2. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOMEID:

3. Navigate to the values you want to view or modify by double-clicking the 
appropriate keys.

The left-hand side of the window shows the hierarchy of registry keys, and the 
right-hand side of the window shows various values associated with a key.

4. Double-click the parameter to edit.
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The String Editor dialog box appears:

5. Make any necessary edits.

6. Click OK.

7. Choose Exit from the Registry menu.
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Working with Oracle Web Publishing

Assistant

This chapter discusses how to use Oracle Web Publishing Assistant. 

Specific topics discussed are:

■ Before You Start

■ Creating New Web Page Queries

■ Administering Web Page Queries
istant 3-1
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Before You Start
Before you begin using Oracle Web Publishing Assistant, consider:

Issue To implement...

Enlarge the event queue log file size if:

■ you have more than 10 Web page queries in the 
listing

■ you update 10 more Web page queries a day

1. Choose Start > Programs > Administrative Tools > 
Event Viewer.

2. Choose Log Settings from the Log menu.

The Event Log Settings screen appears.

3. Select the Application log type from the Change 
Settings drop-down list box.

4. Set the Maximum log size to 30016 Kilobytes (K).

5. Set Event Log Wrapping to Overwrite events older 
than 7 days.

The limit of queries stored in the Oracle Web 
Publishing Assistant repository is 65535 queries.

This limit is inherent in the software. You cannot 
change this limit.

The maximum characters per column returned from 
the database is 4000 characters.

This limit is inherent in the software. You cannot 
change this limit.

Use domain shared or Oracle OPS$ accounts 1. Choose Start > Settings > Control Panel.

2. Double-click Services.

3. Double-click the service OracleWebAssistant from 
the listing.

The Service dialog box appears.

4. Select This Account.

5. Enter your (domain) user account in the This 
Account field, or alternatively, click “...” to select 
your account.

6. Enter your (domain) user password, and confirm.

7. Click OK to dismiss the dialog box, and save your 
changes.

8. Select OracleWebAssistant from the service listing, 
and click Stop.

9. Click Start to start the service and use the new 
account.

10. Click Close to close the control panel.
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Creating New Web Page Queries
Oracle Web Publishing Assistant merges the results of your database query with an 
HTML template (use the default template provided with the product or a template 
that you design). The result is a Web page query. 

To create a new Web page query:

1. If you are using multiple Oracle homes functionality, the command to start a 
tool includes a HOME_NAME, where HOME_NAME indicates the name of a 
different Oracle home. Note that the first Oracle home created on your computer 
does not have HOME_NAME appended to the group. For example:

To start Oracle Web Publishing Assistant from the first Oracle home, choose:

Start > Programs > Oracle for Windows NT > Application Development > 
Oracle Web Publishing Assistant. 

To start Oracle Web Publishing from an additional Oracle home, choose:

Start > Programs > Oracle for Windows NT - HOME_NAME > Application 
Development > Oracle Web Publishing Assistant.

The Oracle Web Publishing Assistant Welcome screen appears:

Determine how you want the Web page to look, before 
entering a query to create a Web page. Oracle Web 
Publishing Assistant provides you with sample 
templates that you can use (ORACLE_
BASE\ORACLE_
HOME\ASSISTANTS\OWAST\SAMPLES\*.HTX), or 
you can create your own template using any HTML 
editor. 

See "Designing Templates" on page 2-2.

Issue To implement...
Working with Oracle Web Publishing Assistant 3-3



Creating New Web Page Queries
The first time you run Oracle Web Publishing Assistant, a Create Web Page 
button appears. This button will not appear in subsequent uses of Oracle Web 
Publishing Assistant if you have Web page queries scheduled.

The next time you want to create a new Web page query, click New in the 
toolbar to launch the Create Web Page Wizard.

If you do not want the welcome screen to appear the next time you start the 
Oracle Web Publishing Assistant, clear the check box on the bottom of the 
welcome screen.

2. Click Create Web Page.

The Create Web Page Wizard (Step 1 of 4) screen appears.
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3. Enter database login information, and click Next:

The next screen, Create Web Page Wizard (Step 2 of 4) appears.

Field Enter

User Name A valid user name for the database you want to access.

Password The password for the account.

Database The Net8 service name or database alias of the database 
you want to connect to. Leave the field blank if you want to 
connect to a local database.
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4. Select a method for creating a query, and click Next after building or entering 
your query statement:

The next screen, Create Web Page Wizard (Step 3 of 4) appears.

Query Method Description

Build a query from a database hierarchy.

You can view the structure of the database, and select a 
table, view, synonym, or multiple columns of an object. 

Further customize your query by clicking Specify 
Additional Query Criteria. Provide additional criteria 
such as WHERE or ORDER BY clauses.

Enter a query as a SQL statement.

Enter the SQL ‘SELECT’ statement in the field 
provided. 

You can also import a SQL statement from a text file by 
clicking the Import SQL From Text File button.
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5. Select a scheduling option, and click Next
.

Scheduling Option Description

Immediately

Oracle Web Publishing Assistant immediately 
generates your Web page. 

To view the page, open the file in your Web browser. 
The default directory for generated pages is ORACLE_
BASE\ORACLE_HOME\ASSISTANTS\OWAST, 
where ORACLE_BASE\ORACLE_HOME is your 
Oracle home directory and \OWAST is the Oracle Web 
Publishing Assistant directory. The file will not be 
included in the file listing.

Once

Select the specific date and time of the day within the 
next 31 days to create your Web page. Oracle Web 
Publishing Assistant will create the Web page once at 
the time and day you specified. You can select only one 
day and time. You cannot specify multiple create 
sessions with this scheduling option.

On Day(s) of the Week

Select the day or days of the week to create your Web 
page. Oracle Web Publishing Assistant will 
automatically create the Web page on that day (or 
those days) and time, every week. You can choose any 
number of days and one time for that day. For 
example, you can choose to have your Web page 
created at 2:00 P.M. every Monday, Wednesday, and 
Friday of every week.
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On Date(s) of the Month

Select the date or dates of the month you want Oracle 
Web Publishing Assistant to create your Web page. You 
can select any number of dates and one time of day to 
create your Web page. For example, you can choose to 
have your Web page created at 7:00 A.M. every 1st and 
15th of every month.

At Regular Intervals

Specify the time intervals at which Oracle Web 
Publishing Assistant should create your Web page. You 
can specify the time interval (minutes, hours, or days) 
between Web page builds. For example, you can 
choose to have your Web page created every 5 
minutes, every 36 hours or every 31 days. The 
maximum time interval is 744 hours (31 days).

When Data Changes

Automatically updates your Web page whenever the 
relevant data in the database is modified. You can only 
use this scheduling option when you select a table 
from the database hierarchy to build your query.

Scheduling Option Description
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The next screen Create Web Page Wizard - Step 4 of 4 appears:

Manually

Your Web page is generated whenever you decide to 
generate it. After creating the Web page query with the 
Create Web Page wizard, select the file from the listing, 
and click Generate.

Scheduling Option Description
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6. Enter the file name of the Web page you want to create, or click Browse to 
search for a location of an existing file name.

If the file is located on a network drive, use the Universal Naming Convention 
(UNC) name instead of the network drive letter. For example:

In addition, ensure that the OracleWebAssistant service is running under the 
user account with access to the network drive.

a. Choose Start > Settings > Control Panel.

b. Double-click Services.

c. Double-click OracleWebAssistant.

d. This account should be set to the user account with access to the network 
drive.

7. Specify whether you want Oracle Web Publishing Assistant to use a default 
template or a template file that you have already created. Browse to locate the 
file, or enter the file name in the field. Click Finish.

The Summary Screen appears.

8. Click OK to dismiss the screen.

All Web pages, except those scheduled to be created Manually, are 
automatically generated at this time. If you specified a scheduling option for 
some time in the future, your Web page will also be regenerated at that 
scheduled time.

Continue to the next section "Administering Web Page Queries" on page 3-11 to 
learn how to modify and maintain your Web page queries.

Use Instead of

\\servername\filename.htm F:\filename.htm
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Administering Web Page Queries
Using Oracle Web Publishing Assistant, you can perform administrative tasks on 
your Web page queries, such as changing the resulting Web page formatting, 
modifying the query syntax, and scheduling updates. Oracle Web Publishing 
Assistant provides an easy-to-use, graphical interface for you to administer your 
Web page queries. The menu and toolbar are briefly described in the section "Before 
You Start" on page 3-2.

After you have created and scheduled your Web page queries, the (Web page query) 
files appear in the file listing of the Oracle Web Publishing Assistant. Oracle Web 
Publishing Assistant enables you to maintain your Web pages graphically.

This section describes the following administrative tasks:

■ Previewing a Scheduled Web Page Query

■ Generating Web Page Queries

■ Deleting Scheduled Web Page Queries

■ Viewing and Modifying Properties of Web Page Queries

■ Refreshing the Listing of Web Page Queries

■ Editing Templates

■ Editing Query Syntax

Previewing a Scheduled Web Page Query
To preview a Web page query:

■ Double-click the Web page query file name from the listing.

Alternatively, select the file name from the listing, and click Preview on the 
toolbar. You can also choose Preview from the Web Page menu, or using the 
right mouse button, right-click on the file name. Choose Preview from the 
pop-up menu.

Due to the asynchronous processing model used by Oracle Web Publishing 
Assistant, it is possible that your scheduled Web page query has not yet been 
generated. If it has not been generated, Oracle Web Publishing Assistant asks if 
you want to generate it now.

Oracle Web Publishing Assistant launches your Web browser, if you have 
associated your Web browser with the Web page query file type.
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Generating Web Page Queries
To generate scheduled Web pages:

1. Select the Web page query file name from the listing.

2. Click Generate on the toolbar, or from the Web Page menu, choose Generate.

Alternatively, using the right mouse button, right-click the file name. Choose 
Generate from the pop-up menu.

Oracle Web Publishing Assistant generates the Web page immediately and 
refreshes the listing automatically.

3. Double-click the Web page query file name in the listing to view.

Oracle Web Publishing Assistant launches your Web browser.

Deleting Scheduled Web Page Queries
To delete a scheduled Web page:

1. Select the Web page query file name to be deleted from the listing.

2. Click Delete on the toolbar, or from the Web Page menu, choose Delete.

Alternatively, using the right mouse button, right-click on the file name. From 
the pop-up menu, choose Delete.

Deleting the Web page query file name in this way does not delete the related 
.HTX or .HTM files.

Viewing and Modifying Properties of Web Page Queries
View properties of Web page queries to review and modify the settings used to 
create the page. 

To view and modify the properties of the Web page queries:

1. Select the Web page query file name from the listing.

2. Click Properties on the toolbar, or choose Properties from the Web Page menu.

Alternatively, using the right mouse button, right-click the file name. Choose 
Properties from the pop-up menu.

The Properties screen appears.

3. Click the tabs to see the properties:
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Tab Description

Login Shows the User Name, Password (encrypted), and Database 
(service name or database alias) used to connect to a 
database.

You can edit any field. Click Apply or OK to save your 
changes.

Query Shows the SQL statement used to query the database.

You can edit the query syntax from within this window:

1. Click Apply or OK after you edit the query. 

The Modify Template dialog box appears.

2. Select an option, and click OK.

If you decide to edit your current template, Oracle Web 
Publishing Assistant automatically launches the default 
editor application for template files.

3. Edit the current template if necessary.

4. Click OK to close the Properties screen.

You cannot change the query if your scheduling option is 
When Data Changes. If your scheduling option is When 
Data Changes, and you wish to change your query, then you 
need to modify your scheduling option before you modify 
your query.

Scheduling Shows the scheduling option details you specified while 
creating the Web page query.

You can change your scheduling option. Unless your 
original query was scheduled as When Data Changes, that 
scheduling option will not appear as a choice in this tab.
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Refreshing the Listing of Web Page Queries
Refreshing is automatic in this release of Oracle Web Publishing Assistant. If you 
want to refresh immediately, choose Refresh from the View menu.

Editing Templates
You can edit templates from within the Properties screen or by opening the template 
file using your HTML editor.

To edit the template from within the Properties screen:

1. Select the Web page query file name from the listing.

2. Click Properties on the toolbar, or from the Web Page menu, choose Properties.

Alternatively, using the right mouse button, right-click the file name. From the 
pop-up menu, choose Properties.

3. Click the File Options tab.

This tab shows where your Web page query is stored (file name and full path), 
and it shows which template you used to create the query.

4. Click Edit.

File Options Shows the Web page query file name and full path. Shows 
the location of the template used to create the Web page.

You can edit the template from this screen:

1. Click Edit.

Oracle Web Publishing Assistant launches the program 
associated with editing HTX files. If you do not have a 
program associated with HTX files, Oracle Web Pub-
lishing Assistant launches Notepad.

2. Edit the template, and save.

3. Oracle Web Publishing Assistant uses the revised 
template for the next scheduled or the next requested 
Web page generation.

The Query ID field displays a number that can be used 
when troubleshooting Oracle Web Publishing Assistant. See 
Appendix B, "Troubleshooting" for more information.

Tab Description
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The template is opened with the program associated with that file type, or if 
there is no program associated, Oracle Web Publishing Assistant launches 
Notepad.

5. Edit the template.

6. Save the file.

Oracle Web Publishing Assistant uses the revised template file for the next 
scheduled or next requested Web page generation.

Editing Query Syntax
To change your query:

1. Select the Web page file name from the listing.

2. Click Properties on the toolbar, or from the Web Page menu, choose Properties.

Alternatively, using the right mouse button, right-click the file name. From the 
pop-up menu, choose Properties.

3. Click the Query tab.

4. Edit the SQL statement in the field.

5. Click Apply or OK.

The Modify Template dialog box appears.

6. Select an option, and click OK.

If you decide to edit your current template, Oracle Web Publishing Assistant 
automatically launches the default editor application for template files.

7. Edit the current template if necessary.

8. Click OK to close the Properties screen.
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Using the Tutorials

This chapter discusses how to use the three tutorials included with Oracle Web 
Publishing Assistant. Specific topics discussed are:

■ About the Tutorials

■ Tutorial 1: Using the Generated Default Template

■ Tutorial 2: Using the EXAMPLE2.HTX Template

■ Tutorial 3: Using the EXAMPLE3.HTX Template
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About the Tutorials
Each tutorial in this chapter uses increasingly more complex templates to format 
retrieved database information. To learn how the different effects are achieved, view 
the template structure in an HTML editor or view the source code from within your 
browser.

Tutorial 1: Using the Generated Default Template
The first tutorial uses the default template. This template is a simple page, which 
will display information retrieved from one table using a Java applet. The database 
query used in the tutorial retrieves information from the SCOTT.EMP table 
(installed automatically when you install Oracle8 using the Typical Installation 
option). 

Oracle Web Publishing Assistant merges the results of the database query with the 
template. The result is a Web page query. All of your scheduled Web page queries are 
listed in the Oracle Web Publishing Assistant file listing.

To create the Web page:

1. Start Oracle Web Publishing Assistant.

Choose Start > Programs > Oracle for Windows NT > Application Development 
> Oracle Web Publishing Assistant.

Oracle Web Publishing Assistant appears. If you have never created a Web page 
query using the Create Web Page Wizard before or if you do not have any Web 
page queries scheduled in the listing, then the welcome screen appears with a 
Create Web Page button. To bypass the welcome screen upon subsequent use of 
Oracle Web Publishing Assistant, clear the check box on the screen.
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2. Click Create Web Page, or click New on the toolbar.

The screen Create Web Page Wizard - Step 1 of 4 appears:

3. Enter database login information, and click Next:

The screen Create Web Page Wizard - Step 2 of 4 appears.

4. Select the Build a Query from a Database Hierarchy method for creating a 
query.

Field Description

User Name Enter the user SCOTT.

Password Enter the password TIGER.

Database Leave the field blank to connect to the local 
database.
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5. Click Local Database, and navigate to SCOTT > TABLE > EMP:

6. Select EMP, and click Next.

The screen Create Web Page Wizard - Step 3 of 4 appears.

7. Select the Once scheduling option.

Select any day and any time in the future to generate the Web page:

8. Click Next.
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The screen Create Web Page Wizard - Step 4 of 4 appears:

9. Accept the default file name of the Web page (WEB.HTM). 

Select Generate Default Template File.

10. Click Next.

The Summary Screen appears, confirming that Web page creation was successful. 
Click Finish to dismiss the screen.

Note: All Web pages, except those scheduled to be created 
Manually, are automatically generated at this time. If you specified 
a scheduling option for some time in the future, your Web page will 
also be regenerated at that scheduled time.
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11. The resulting Web page (the default file name is WEB.HTM) looks like this:

Tutorial 2: Using the EXAMPLE2.HTX Template
The second tutorial queries the SCOTT.EMP table (installed automatically when 
you install Oracle8 using the Typical Installation Option) and formats the retrieved 
information using the template EXAMPLE2.HTX.

To create the Web page using the template EXAMPLE2.HTX:

1. Start Oracle Web Publishing Assistant.

Choose Start > Programs > Oracle for Windows NT > Application Development 
> Oracle Web Publishing Assistant.

Oracle Web Publishing Assistant appears. To bypass the welcome screen upon 
subsequent use of Oracle Web Publishing Assistant, clear the check box.
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Tutorial 2: Using the EXAMPLE2.HTX Template
2. Click Next. The Oracle Web Publishing Assistant appears:

3. Click New. The screen Create Web Page Wizard - Step 1 of 4 appears:
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Tutorial 2: Using the EXAMPLE2.HTX Template
4. Enter database login information, and click Next:

The screen Create Web Page Wizard - Step 2 of 4 appears.

5. Select the Enter a SQL Statement method for creating a query, and click Import 
SQL from Text File.

Use the provided SQL script to enter the SQL statement. The SQL script is 
stored in an ASCII text file located in the directory ORACLE_BASE\ORACLE_
HOME\ASSISTANTS\OWAST\SAMPLES.

6. Select EXAMPLE2.SQL, and click Open. The SQL script appears in the field:

Field Description

User Name Enter the user SCOTT.

Password Enter the password TIGER.

Database Leave the field blank to connect to the local 
database.
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Tutorial 2: Using the EXAMPLE2.HTX Template
7. Click Next. The screen Create Web Page Wizard - Step 3 of 4 appears:

8. Select the Once scheduling option.

9. Select any day and any time in the future to generate the Web page.

The screen Create Web Page Wizard - Step 4 of 4 appears.

10. Enter EXAMPLE2.HTM as the file name of the Web page. 

11. Select Use Template File, and navigate to ORACLE_BASE\ORACLE_
HOME\ASSISTANTS\OWAST\SAMPLES\EXAMPLE2.HTX:
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Tutorial 3: Using the EXAMPLE3.HTX Template
12. Click Next.

The Summary Screen appears, confirming that Web page creation was successful. 
Click Finish to dismiss the screen.

The resulting Web page EXAMPLE2.HTM looks like this:

Tutorial 3: Using the EXAMPLE3.HTX Template
The third tutorial uses a template which incorporates the use of frames, enabling 
you to merge two separate query statements into one Web page. This tutorial 
queries the SCOTT.EMP table (installed automatically when you install Oracle8 
Enterprise Edition or Oracle8 using the Typical Installation Option) and formats the 
retrieved information using the templates EXAMPLE3.HTX and DETAIL.HTX.

To create the Web page:

1. Start Oracle Web Publishing Assistant.

Choose Start > Programs > Oracle for Windows NT > Application Development 
> Oracle Web Publishing Assistant.

Oracle Web Publishing Assistant appears. To bypass the welcome screen upon 
subsequent use of Oracle Web Publishing Assistant, clear the check box.
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Tutorial 3: Using the EXAMPLE3.HTX Template
2. Click Next. The Oracle Web Publishing Assistant appears:

3. Click New.

The screen Create Web Page Wizard - Step 1 of 4 appears:
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Tutorial 3: Using the EXAMPLE3.HTX Template
4. Enter database login information, and click Next:

The screen Create Web Page Wizard - Step 2 of 4 appears.

5. Select the Enter a SQL Statement method for creating a query, and click Import 
SQL From Text File.

Use the provided SQL script to enter the SQL statement. The SQL script is 
stored in an ASCII text file located in the directory ORACLE_BASE\ORACLE_
HOME\ASSISTANTS\OWAST\SAMPLES.

6. Select EXAMPLE3.SQL, and click Open. The SQL script appears in the field:

7. Click Next.

The screen Create Web Page Wizard - Step 3 of 4 appears.

Field Description

User Name Enter the user SCOTT.

Password Enter the password TIGER.

Database Leave the field blank to connect to the local 
database.
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Tutorial 3: Using the EXAMPLE3.HTX Template
8. Select the Once scheduling option. Select any day and any time in the future to 
generate the Web page:

9. Click Next. The screen Create Web Page Wizard - Step 4 of 4 appears:

10. Enter MAIN.HTM as the file name of the Web page. 

Select Use Template File. Navigate to ORACLE_BASE\ORACLE_
HOME\ASSISTANTS\OWAST\SAMPLES\EXAMPLE3.HTX. 
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Tutorial 3: Using the EXAMPLE3.HTX Template
11. Click Next.

The Summary Screen appears, confirming that Web page creation was successful. 
Click Finish to dismiss the screen.

The resulting Web page MAIN.HTM looks like this:

The Web page you have created thus far is similar to the Web page in the 
second tutorial, except that the employee names are linked. 

The next section explains how you can further develop the page by 
incorporating a frame which shows a set of information from a separate query 
on the same Web page. In this example, you will create a frame which shows 
the details of each employee listed in the first column of the Web page when the 
name of that employee is clicked.

Note that when you pass the mouse pointer over the employee name, an HTML 
file is linked to the name. The file each employee name points to is what you 
will be creating in the next section, such as EMP#HTM, where EMP# is the 
employee number. After you complete the next section, the result will be a file 
EXAMPLE3.HTM which incorporates the files MAIN.HTM and EMP#.HTM.

To illustrate, the first employee listed is KING. The employee number 
associated with KING is 7839. In order to create the frame of information, you 
must know the employee number of each employee. This example will stop 
with employee KING, but you can create as many as you want.
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Tutorial 3: Using the EXAMPLE3.HTX Template
To continue with Tutorial 3 and create the second part of the Web page:

12. Repeat Step 3.

13. Repeat Step 4.

14. Select the Enter a SQL Statement method for creating a query, and click Import 
SQL From Text File.

Use the predefined SQL script EXAMPLE3A.SQL to enter the SQL statement. 
For more information on how to use the script, see Step 5.

The statement reads:

select empno,ename,job,sal,comm,hiredate,dname from emp a, dept b where 
a.deptno = b.deptno and empno=emp# order by sal desc;
where emp# is the employee number.

15. Click Next.

16. Enter 7839.HTM as the file name for the first employee record for employee 
KING.

Select Use Template File. Navigate to ORACLE_BASE\ORACLE_
HOME\ASSISTANTS\OWAST\SAMPLES\DETAIL.HTX. 

17. Click Next.

The Summary Screen appears, confirming that the Web page creation was 
successful. Click Finish to dismiss the screen.
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Tutorial 3: Using the EXAMPLE3.HTX Template
18. Open the resulting Web page EXAMPLE3.HTM (located in ORACLE_
BASE\ORACLE_HOME\ASSISTANTS\OWAST\SAMPLES directory) in your 
Web browser. The page looks like this:

19. Repeat Steps 10 through 16 for each frame you want to create.

Note that only the files MAIN.HTM and EMP#.HTM appear in the file listing. 
The file EXAMPLE3.HTM will not appear in the file listing of Oracle Web 
Publishing Assistant:

When you are finished creating the frames, your resulting Web page will allow 
a user to see the Employee Details of each of the employees by clicking on the 
employee name. The information contained in the frame shows the information 
relevant to the selected name.
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Oracle Web Publishing Assistant Repo
A

Oracle Web Publishing Assistant

Repository

The Oracle Web Publishing Assistant Repository stores configuration information. 
The repository must reside in the registry of the same machine where Oracle Web 
Publishing Assistant service is running. 
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Table A–1 Repository Registration Keys

The registry keys (values) are part of the service name registry key itself, allowing 
for multiple repositories, one for each service. Key names which appear in italics 
can exist multiple times. All keys listed are sub-keys except for the lowest level 
which are values.

Service 
Name Sub-key Sub-key Sub-key Value Description of Value

Web pages

QueryID Unique identifier, created for each query

Database

Userid Oracle userid

Password Encrypted

OID Oracle identifier: SID or TNS

Query SQL query

Persistent Keep connected to database

Scheduling

Type Once/repeat/data change/every...

Date Complete date/time

Repeat Unit Minutes/hours/days/month

Repeat Number of repeat units

Properties

Name Name of web page

Path Location of web page

Template Name of template to use

Parameters Template parameters

Created Data query created
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Troublesho
B

Troubleshooting

This appendix discusses troubleshooting Oracle Web Publishing Assistant.

Questions and Answers
This section includes answers to some common questions about Oracle Web 
Publishing Assistant.

My file does not immediately refresh in the Modified column when I click 
Generate. What should I do?
The file listing will automatically refresh within one minute. If you want to refresh 
immediately, then choose Refresh from the View menu.

When deleting a Web page query, I get the error message “Unable to remove job 
from Windows NT scheduler”. What does this message mean?
This message is informational. Usually this message indicates that the job has 
already been removed from the Windows NT scheduler.
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Questions and Answers
How can I display the Web page query file names in alphabetical order in the file 
listing?
Click the File Name column. The Web page query file names will be sorted in 
alphabetical order, rather than in order of the time created. If you click File Name 
again, then the listing order will reverse.

Can I order Web page queries in different ways?
You can order Web page queries in the listing by File Name, Location, Schedule, and 
(time and date) Modified. Click on the column name you wish to sort by.

I deleted a Web page query from the listing, but I still see the .HTM and .HTX files 
on my hard drive. Why?
Deleting the Web page query from the listing only removes the item from the 
repository and does not remove any of the associated .HTM or .HTX files. Remove 
these files manually.

The scheduling choice When Data Changes does not always appear as an option 
when I use the Create Web Page Wizard. Why?
You can only select When Data Changes if you select a table from the database 
hierarchy when you use the Create Web Page Wizard.

click here
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Questions and Answers
I created a Web page query using the scheduling option Immediately. Why doesn’t 
the Web page query appear on the listing?
The scheduling option Immediately creates the Web page once when you finish with 
your Web page query creation. You have not scheduled it to be generated again. 
Therefore, it will not appear in the listing. To view the Web page query, open the file 
from within your Web browser application.

I am trying to build a database query using the database hierarchy in the Create 
Web Page Wizard, but I keep getting an error message indicating that the query 
specified is invalid. Why?
Check to see if you specified additional query criteria. The additional query criteria 
is appended to your query, and incorrect syntax can cause the query to be invalid.

If my Web page query does not get generated, where is the error recorded?
All errors are logged in the Windows NT application event queue. Events in the 
application event queue can be viewed using the Windows NT Event Viewer. 
Choose Start > Programs > Administrative Tools > Event Viewer.

I have a Web page query which is scheduled to be updated on a regular basis, but 
it is not being updated anymore. What causes this condition, and how can I restart 
updates without restarting the service?
Check the Windows NT Event Viewer to see why the Web page query is no longer 
being updated. To restart updates, start Oracle Web Publishing Assistant, and click 
Generate. The Web page query is updated, and it will continue to be updated 
according to the scheduling option you set.

If I click Generate several times in rapid succession, many errors appear in the 
Event Viewer. Why?
You cannot generate a Web page query that is already being generated. If a Web 
page query is already being generated, then the page generator initialization will 
fail. An error will be written in the application event queue. You can ignore the 
errors since they will have no impact on Oracle Web Publishing Assistant other than 
the page will not be generated.

What are the OWPA_ trigger(s) and tables that are in my database account?
The trigger(s) and tables with the prefix OWPA_ are Oracle Web Publishing 
Assistant objects. They are used to enable the Oracle Web Publishing Assistant 
service to monitor changes in the database.
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Questions and Answers
How can I copy all of my Web page queries to another PC?
Oracle Web Publishing Assistant does not feature an export function, but you can 
use the Windows NT registry editor to export the repository information from the 
registry:

1. At the MS-DOS command prompt, type:

C:\> REGEDIT

2. Navigate to HKEY_LOCAL_
MACHINE/SYSTEM/CurrentControlSet/Services/OracleWebAssistant/WebP
ages.

All of the Web page queries are listed under WebPages.

3. Select the Web page query you want to export by clicking once on the number 
corresponding to the Query Id which appears in the File Options tab of the 
Properties window. See “Viewing and Modifying Properties of Web Page 
Queries” on page 3-12.

4. From the Registry menu, choose Export Registry File...

5. Specify the volume you want to export the file to, and enter a file name. 
Confirm that the Export Range is correct.

6. Click Save.

If I select the On Date(s) of the Month scheduling option and choose 31,when will 
updates occur given that not all months have 31 days?
The Web page will be updated only in those months that have 31 days.
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Questions and Answers
I cannot set my system default locale to French. Why?
Due to French government regulations on encryption, you cannot set your system 
default locale to French (Standard) in the Regional Settings Control Panel of 
Windows NT. 

I cannot enter the time using the spin box with the default time style. Why?
In some language versions on Windows NT, the spin box for entering time in Web 
Publishing Assistant does not function properly with the default time style. To work 
around this problem, change the default time style from within the Control Panel 
before running the Assistant. To change the default time style, click on the "Regional 
Settings" icon in the Control Panel and select the "Time" property page, and change 
the time style to "hh:mm:ss".
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